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Altium Designer 6.9 brings significant refinements to 3D 
PCB Visualization combined with a number of smaller 
enhancements and improved system-wide support for 
existing technologies. Many of these improvements are 
based on feedback directly from you, the engineers and 
designers developing designs in Altium Designer. 

 

 

Altium understands that improving the electronic product design platform isn’t just about adding new 
features, but also about refining and strengthening existing ones. Electronics technology moves fast 
and your design systems need to keep up. 

Altium Designer 6.9 delivers a number of enhancements designed to increase your effectiveness, 
improving features you depend upon to deliver better designs faster. PCB Visualization has been 
further enhanced with new 3D STEP technologies. STEP, the STandard for the Exchange of Product 
model data is becoming a preferred standard for ECAD to MCAD data exchange – allowing transfer of 
3D models between CAD applications. 

Embedded tools support for FPGA development continues to improve, enabling you to take advantage 
of new core technologies and optimize your power efficiency. Expanding options for peripherals, Altium 
Designer 6.9 delivers three new peripheral cores, a power monitor, and context-sensitive help support 
for C keywords and standard functions. 

With this release, new web updating through the web portal will be introduced as a means of taking 
advantage of a wide range of future online services yet to come! 

These are just some of the new enhancements delivered by this significant new release of Altium 
Designer. To learn more about the new capabilities and productivity benefits offered in Altium Designer 
6.9, read on! 

Seeing is believing – read more and watch demos of Altium 
Designer 
Altium's DEMOcenter gives you the opportunity to walk through the extensive design capabilities of 
Altium Designer featured as individual demos, each only taking a couple of minutes, making this a 
quick and easy way for you to browse the areas of most importance to you. 

If you’d like to read more about updates in Altium Designer, as well as watch short videos about some 
of the exciting new features, then visit the What’s New in Altium Designer page on the website and 
enjoy the action. Click the link below to read more and watch the videos. 

http://www.altium.com/Evaluate/DEMOcenter
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New – STEP Models into 3D Bodies 
When visualizing PCBs and components in 3D, it's now possible to import 3D STEP models to 
represent component bodies to provide further realism. STEP models can be loaded directly into 
component footprints in the PCB Library Editor.  

The associated 3D Body dialog now features a Model section allowing you to load, update or remove 
STEP model files quickly and easily. New commands in the PCB Library Editor Tools menu and 3D 
Body dialog have also been introduced to accurately manipulate and orient STEP models in the 3D 
workspace.  

 

 

Figure 1. Amazing transformation of your component bodies in 3D using STEP models are now possible. 

Viewing the models is easy – once you’re in 3D mode, hit the ‘L’ shortcut key to bring up View 
Configurations dialog and turn on the Show Step Models checkbox. 
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New – 3D STEP Export  
Altium Designer 6.9 expands new STEP support to include exporting a 3D STEP format file to your 
preferred mechanical CAD system. With the introduction of 3D Visualization in the PCB Editor, 
complete boards can be exported as 3D STEP AP214 file format.  

 

Figure 2. Export options allow you to customize output according to all or selected components, STEP models or 
Extruded Component Shapes, and All or selected Holes. 

The new 3D export feature is launched from the PCB Editor, File » Save As. Simply change the Save 
As file type to Step File (*.step, *.stp) and press Save.  

New – 3D Origin Marker 
New tools in Altium Designer 6.9 help accurately orient 
and position imported STEP Models in the 3D workspace, 
the first of these being the 3D Origin Marker. 
The Physical Materials page of the View Configurations 
dialog has options to display an origin marker when in 3D 
view mode. The marker represents the 0, 0, 0 positions for 
the X, Y, and Z-axis respectively. 
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New – Transparent Layer Mode options 
Further complementing the 
capabilities of PCB Visualization, 
additional options in the PCB 
Preferences give added flexibility 
when working with Transparent 
Layer Modes.  

 

 Figure 3. New options for Transparent Layer Modes are found in Tools » 
Preferences PCB Editor page. 

Layer ordering allows more 
control over the layer drawing 
order for transparent layer modes.  
Full Brightness and Ordered 
Blending (shown below) enables 
the current or selected layer to 
appear on top of other layers 
(according to the Layer Drawing 
Order) in transparent layer mode 
and also for the colors of objects 
in transparent layer modes to 
have improved brightness and 
contrast.  

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 4. Transparent Mode is shown with Full Brightness on the left and in Ordered Blending on the right. 
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New – 3D Shadow and Object Color by Layer 
This effect can be 
easily added to your 3D 
design through the 
Preferences dialog 
giving enhanced 
visibility in dense 
designs. Shadowing 
can only be seen when 
viewing the PCB from 
above which helps 
prevent confusion 
between the viewing 
the top and bottom of 
the board.  

As a complement to 
shadowing, there is 
also Object Color by 

Layer option in the Physical Materials page of the View Configurations dialog that allows display of 
objects either in their system-based 2D layer color or using the colors specified in the dialog 

Figure 5. Enabling Shadowing and Object Color by Layer makes it easier to discern 
the layers of objects from the 3D view. 

New – 3D 
Image onto 
clipboard 

 
Figure 6. A representative bitmap pasted from Altium Designer to an external 
application. 

3D image to clipboard 
takes a snapshot of the 
main design window view 
in 3D and stores it as a 
bitmap on the Windows 
clipboard for pasting into 
other applications. 
Whatever is displayed in 
the main window of 
Altium Designer (bar 
panels and dialog boxes) 
is what will be placed on 
the clipboard. You even 
have control over the 
resolution of the bitmap 
image. 

AR0146 (v1.0) March 6, 2008 5 



What’s New in Altium Designer 6.9 

New – Jumper connections 

 
Figure 7. Jumper connections are shown as curved connection lines in the PCB Editor. 

A new jumper feature allows you to set a 
jumper connection (a physical connection 
between pads but not using tracks on 
PCB, a separate wire instead) between 
pads on a component. This is especially 
useful when crossing tracks on a single 
layer board.  

 
Figure 8. Jumper IDs can be configured from within the Pad 
properties dialog 

Jumper connections define electrical 
connections between component pads 
that are not physically routed with 
primitives on the PCB. These are 
especially useful on single layer boards, 
where a wire is used to jump over tracks 
on the one physical layer, or even as 
complex as designing with a ‘crossover’ 
switch. The Design Rules Checker will 
not report jumper connections as 
unrouted nets. 

Pads within a component can be labeled 
with a Jumper ID value from within the 
Pad dialog. Pads that share the same 
Jumper ID and electrical net tell the 
system that there is a legitimate, although 
physically unconnected, connection 
between them. 
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New – Units Toggle 

Many dialogs now feature a units toggle control   in the top-left corner that will change the units of 
measurement currently used in the dialog between the metric and imperial. Shortcut CTRL + Q can 
also be used in dialogs where this control is present. Toggling units at any time does not affect system 
accuracy as all numerical calculations are carried out at system resolution. 

 
Figure 9. The current unit of measurement displays in the dialog title area as shown here. You can also control the 
display precision and rounding of metric units through the Tools » Preferences dialog. 

Improved – Special Strings 
Especially useful for design documentation, special strings act as placeholders for PCB design or 
system-based information and are only populated with information when generating manufacturing 
output data.  

To use a special string on a PCB, place a string object and set its text to be one of the special string 
names. Special strings provide manufacturing records for the software build number of the version of 
Altium Designer that was used during output generation and for the current revision number of the 
document.  
• .Application_BuildNumber – places the version of Altium Designer on the PCB document that the 

PCB is currently loaded in. When generating Gerber output, this string will record the software build 
that the design was created on. 

• .VersionControl_RevNumber – once placed, displays the current revision number of the 
document. Version control must be used for this string to contain any information. 

• .Computer Name – places the name of the machine that the PCB is currently loaded on. 
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New – Design Refactoring 
Making changes on the fly and restructuring your schematic design is more flexible than ever with 
Design Refactoring. Design Refactoring converts existing Schematic Sheets into Device Sheets, and 
converts Device Sheets into Schematic Sheets. Parts can also be converted to ports, and parts can be 
converted to sheet symbols although it’s worth mentioning in this instance that the Unique ID isn’t 
maintained as one part may be converted into many ports. 

Subcircuits can be moved easily between schematic sheets as well. Refactoring of sheets is performed 
at the Sheet Symbol or Device Sheet Symbol level. Design Refactoring automatically maintains 
synchronization with the rest of your design, ensuring that subcircuits in the schematic are always 
linked to their physical instances in the PCB through the maintenance the Unique ID of all subcircuits. 

Figure 10. Converting a Schematic Sheet into a Device Sheet using the Refactor feature 

Found in two convenient locations, Refactoring commands can be launched from both the Edit and 
right-click menu in a schematic document.  

 
Figure 11. Converting a Sheet into a Device Sheet Symbol using the Refactor feature 
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Improved – Publish to PDF 
If you publish a specific set of documents to PDF on a regular basis, you can now use a Batch flag to 
specify your document set and run the Batch Publish to PDF command. Batch preferences are saved 
to the Output Job File. You can create multiple Output Job Files with different batch preferences for the 
same project to suit your needs.  

Figure 12. Access the Batch Publish to PDF command from the Tools menu or by right clicking in the Output Job 
Editor and selecting it from the pop-up menu that appears. 

New – Web updates 
Web updates are now obtained via your SUPPORTcenter account. From the Home Page, simply log 
into your account using your SUPPORTcenter credentials (available through either your local Altium 
Sales and Support Center or Reseller, or you can view contact details listed at 
http://www.altium.com/contacts). Then, use the Check for Updates link to get the latest updates.  

 

Figure 13. Getting your SUPPORTcenter contact details for your account are important for obtaining web updates. 
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New – Power Monitoring for the Desktop Nanoboard  
Power consumption is a critical issue in all appliances and particularly portable devices. Power 
requirements for FPGAs can be complicated and it’s essential to be able to accurately determine 
power drawn in real time in order to assess the appropriateness of the devices for battery-
powered applications. The newest Desktop Nanoboard now includes a new optimization tool Power 
Monitoring for maximizing power efficiency. On-board current sensing circuitry enables you to analyze 
and monitor power consumption in your design and allows you to make direct comparisons between 
different devices and circuit configurations.  

 
Figure 14. In the Power Monitor panel, values for Current and Power are displayed for individual channels and the 
aggregate of the power consumption across the voltage rails is also calculated. 

Access the Power Monitor panel through the Instrument Rack - Nanoboard Controllers panel and 
click the Show Panel button in the Power Monitor section.  Values can also be graphed to show the 
power consumption over time for a particular hardware configuration and design as shown below. It’s 
worth noting that power monitoring functionality is only available on the NB2DSK01.08 and later boards. 
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New – FPGA Peripheral Cores 
Expanding your options for peripherals, Altium Designer 6.9 adds support for three new peripheral 
cores.  For schematic-based design of your main processor system, all peripherals can be found in, 
and placed from, the FPGA Peripherals integrated library (\Program Files\Altium Designer 
6\Library\Fpga\FPGA Peripherals.IntLib). For a design incorporating an OpenBus System, 
all components can be found in, and placed from, the OpenBus Palette panel. 
Corresponding core reference documents can be found in the Help directory (\Program 
Files\Altium Designer 6\Help). 

WB_USB 
The WB_USB peripheral provides the interface between a processor in the FPGA design and an 
external USB Interface device, for subsequent communications over a Universal Serial Bus (USB). The 
peripheral has been built specifically to interface to the EZ-USB SX2™ device (CY7C68001, from 
Cypress Semiconductor). This high-speed (USB 2.0) USB Interface device has a built-in USB 
transceiver and a Serial Interface Engine (SIE), which automatically manages the USB protocol.  

If you are using Altium's Desktop NanoBoard NB2DSK01, the USB-IrDA-Ethernet Peripheral Board 
PB03 features a CY7C68001 device.  

WB_BOOTLOADER 
The WB_BOOTLOADER peripheral provides the ability to automatically load (or bootstrap) from serial 
Flash memory on the Desktop NanoBoard NB2DSK01. The device provides the interface between the 
NB2DSK01'S SPI bus and independent SRAM on the daughter board. Provided the device is enabled 
for boot operation, then as soon as the design is programmed into the daughter board FPGA (or an 
external reset is issued if already programmed) the content of the serial Flash memory device will be 
copied into the SRAM.  

The device is configurable in that you can specify where in SRAM the content copied from the serial 
Flash memory is to be written, and the size of the memory involved in the copy.  

The WB_BOOTLOADER can also be used as a standard SPI Controller, with an optional interface to a 
processor in your design, enabling the processor to communicate with slave SPI-compatible devices 
external to the FPGA in which the design is running. Operating as an SPI Controller, the device is 
functionally identical to the SPI_W peripheral.  

WB_I2S 
Altium Designer's WB_I2S Configurable Wishbone Audio Streaming Controller is used to facilitate data 
transfers over the inter-IC sound (I2S) bus. The I2S bus – developed by Philips as a dedicated serial 
link for digital audio – allows a standardized communication medium for an ever-increasing array of 
digital audio devices. 

The WB_I2S is an enhanced version of the legacy I2S_W peripheral. As part of its configurable nature, 
it allows you to enable, and define, a much larger hardware buffer. With larger FIFO buffers, interrupts 
can be disabled and simple periodic polling of the state of the Transmit and Receive buffers performed 
instead. Additional internal registers are used to store the values for the pointers to the Head and Tail 
of each buffer, enabling you to ascertain how many samples are currently available to be read in the 
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Receive Buffer, and how much sample space is available for writing new samples in the Transmit 
Buffer. 

Like the I2S_W, the WB_I2S provides for transmission and reception of data. Unlike the I2S_W 
however, you can configure the WB_I2S to just transmit data or just receive data. 

Improved – Xilinx EDK Support 
Altium Designer 6.9 now supports the following later versions of the Xilinx EDK (Embedded 
Development Kit): 

• 8.1 and 8.2 

• 9.1 and 9.2 

New – Context-sensitive C language help 
Altium Designer 6.9 brings with it F1 context-sensitive help support for C keywords and standard 
functions. Simply highlight part of the keyword or function of interest, in the C coding editor, to access 
related information directly in the Knowledge Center panel. 

The information can also be found in the document TR0173 C Language Reference, located in the 
\Help folder of the installation. 

Revision History 

Date Version No. Revision

06-Mar-2008 1.0 Altium Designer 6.9 release 

Software, hardware, documentation and related materials:  

Copyright © 2008 Altium Limited. 

All rights reserved. You are permitted to print this document provided that (1) the use of such is for personal use 
only and will not be copied or posted on any network computer or broadcast in any media, and (2) no modifications 
of the document is made. Unauthorized duplication, in whole or part, of this document by any means, mechanical or 
electronic, including translation into another language, except for brief excerpts in published reviews, is prohibited 
without the express written permission of Altium Limited. Unauthorized duplication of this work may also be 
prohibited by local statute. Violators may be subject to both criminal and civil penalties, including fines and/or 
imprisonment. Altium, Altium Designer, Board Insight, Design Explorer, DXP, LiveDesign, NanoBoard, NanoTalk, 
P-CAD, SimCode, Situs, TASKING, and Topological Autorouting and their respective logos are trademarks or 
registered trademarks of Altium Limited or its subsidiaries. All other registered or unregistered trademarks 
referenced herein are the property of their respective owners and no trademark rights to the same are claimed. 

 

12 AR0146 (v1.0) March 6, 2008 


	Seeing is believing – read more and watch demos of Altium Designer 
	 New – STEP Models into 3D Bodies 
	New – 3D STEP Export  
	New – 3D Origin Marker 
	 New – Transparent Layer Mode options 
	 New – 3D Shadow and Object Color by Layer 
	New – 3D Image onto clipboard 
	 New – Jumper connections 
	New – Units Toggle 
	Improved – Special Strings 
	New – Design Refactoring 
	Improved – Publish to PDF 
	New – Web updates 
	New – Power Monitoring for the Desktop Nanoboard  
	 New – FPGA Peripheral Cores 
	WB_USB 
	WB_BOOTLOADER 
	WB_I2S 

	Improved – Xilinx EDK Support 
	New – Context-sensitive C language help 
	Revision History 

